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INSTALLATION GUIDE
NI-CAN™ Software and Hardware

This installation guide contains instructions to help you install your
National Instruments hardware and software. Complete documentation is
in the NI-CAN Hardware and Software Manual, which is available on your
NI-CAN Software for Windows CD in Adobe Acrobat portable document
format (PDF). Refer to the file NI-CAN Hardware and Software
Manual .pdf on the CD or in the NI-CAN\Documentation folder on
your hard drive.

The NI-CAN software on this CD supports Microsoft Windows operating
systems.

This installation guide covers all National Instruments hardware products
for CAN and LIN on the PCI, PCMCIA, PXI, and USB buses. It is written
for users already familiar with Windows.

Install the NI-CAN Software Before the Hardware

Before installing the NI-CAN software, users must first log on as
Administrator or as a user with Administrator privileges. The NI-CAN
setup program must have Administrator privileges because the program
modifies the configuration registry of your system.

Complete the following steps to install the NI-CAN software.

1. Insert the NI-CAN Software for Windows CD into your CD-ROM
drive. The installer launches if your CD-ROM drive plays data CDs
automatically.

If the installer does not launch automatically, navigate to the CD using
Windows Explorer and launch the autorun file from your NI-CAN
Software for Windows CD.

2. The Installation Wizard guides you through the necessary steps to
install the NI-CAN software. You can go back and change values
where appropriate by clicking Back. You can exit the setup where
appropriate by clicking Cancel.

3. Power down your computer when the setup is complete.

4. Proceed to the Install the Hardware section.

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section on
ni.com/legal for more information about National Instruments trademarks. Other product and company names mentioned herein are
trademarks or trade names of their respective companies. For patents covering National Instruments products, refer to the appropriate location:
Help»Patents in your software, the patents . txt file on your CD, or ni . com/patents.
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@ Note If you are using LabVIEW Real-Time (RT), refer to the LabVIEW Real-Time (RT)
Configuration section of Chapter 2, Installation and Configuration, of the NI-CAN
Hardware and Software Manual for more information on installing the NI-CAN software
on your RT system and verifying the installation.

Install the Hardware

This section describes how to install your hardware on the PCI, PCMCIA,
PXI, and USB buses.

Install Your PCI Hardware

A Caution Before you remove the card from the package, touch the antistatic plastic package
to a metal part of your system chassis to discharge electrostatic energy, which can damage
components on your CAN card.

Make sure that your computer is powered off and unplugged.

2.  Remove the top cover (or other access panels) to give yourself access
to the computer expansion slots.

Find an unused PCI slot in your computer.

4. Remove the corresponding slot cover on the back panel of the
computer.

5. Insert the CAN card into the slot with the CAN connector(s) sticking
out of the opening on the back panel. It might be a tight fit, but do not
force the interface into place.

6. Screw the mounting bracket of the CAN card to the back panel rail of
the computer.

7. You can use a RTSI cable to connect your CAN-card RTSI interface to
other National Instruments RTSI-equipped hardware. Refer to the
RTSI section of Chapter 3, NI CAN and LIN Hardware, of the NI-CAN
Hardware and Software Manual for more information about the RTSI
interface on your CAN card.

Replace the top cover (or the access panel to the expansion slot).

9. Proceed to the Verify Your Installation section.

NI-CAN Software and Hardware Installation Guide 2 ni.com



Install Your PCMCIA Hardware

A Caution Before you remove the card from the package, touch the antistatic plastic package
to a metal part of your system chassis to discharge electrostatic energy, which can damage
components on your CAN card.

4,

Insert the card into a free PC Card (PCMCIA) socket.

Connect your PCMCIA-CAN cable to the card. The NI-CAN software
auto-detects which cable has been attached to the card.

You can use a PCMCIA-CAN synchronization cable to connect your
PCMCIA-CAN card to timing and triggering signals on another
device.

Refer to the PCMCIA-CAN section of Chapter 3, NI CAN and
LIN Hardware, of the NI-CAN Hardware and Software Manual for
more information about the PCMCIA-CAN synchronization interface.

Proceed to the Verify Your Installation section.

Install Your PXI Hardware

A Caution Before you remove the card from the package, touch the antistatic plastic package
to a metal part of your system chassis to discharge electrostatic energy, which can damage
components on your CAN card.

© National Instruments Corporation

Make sure that your PXI or CompactPCI chassis is powered off, and
unplug the computer.

Choose an unused PXI or CompactPCI peripheral slot.
Remove the filler panel for the peripheral slot you have chosen.

Touch a metal part on your chassis to discharge any static electricity
that might be on your clothes or body.

Insert the PXI card into the selected slot. Use the injector/ejector
handle to fully inject the card into place.

Screw the front panel of the PXI card to the front panel-mounting rail
of the PXI or CompactPCI chassis.

Proceed to the Verify Your Installation section.

3 NI-CAN Software and Hardware Installation Guide



Install Your USB Hardware

A Caution Before you remove the card from the package, touch the antistatic plastic package
to a metal part of your system chassis to discharge electrostatic energy, which can damage
components on your CAN and LIN hardware.

1. Insert the USB cable into a free USB 1.1 or 2.0 port. The NI-CAN
software auto-detects the CAN and LIN USB hardware.

2. For USB hardware with the synchronization option you can connect
your USB hardware to timing and triggering signals on another device.

Refer to the USB-847x section of Chapter 3, NI CAN and LIN
Hardware, of the NI-CAN Hardware and Software Manual for more
information about the USB-847x synchronization interface.

3. Proceed to the Verify Your Installation section.

Verify Your Installation

1. Power on your computer and start Windows.

A New Hardware Found dialog box appears. If a dialog box appears
and does not go away on its own, choose the default option, Install the
Software Automatically (Recommended), and let the operating
system install the driver files.

If the New Hardware Found dialog box does not appear when you
restart Windows, refer to Appendix A, Troubleshooting and Common
Questions, of the NI-CAN Hardware and Software Manual for more
information.

2. Launch Measurement & Automation Explorer (MAX) and refresh
(press <F5> or choose View»Refresh from the menu). Your CAN and
LIN hardware should be listed now under Devices and Interfaces. To
test all detected CAN and LIN hardware, choose Tools»NI-CAN»
Test All Local Cards from the menu.

3. Proceed to the Connect the Cables section.

Connect the Cables

After you have installed the hardware, connect your cables to the hardware.
Refer to Chapter 4, Connectors and Cables, of the NI-CAN Hardware and
Software Manual for information about the cabling requirements of the
CAN and LIN hardware.

NI-CAN Software and Hardware Installation Guide 4 ni.com



Uninstalling the NI-CAN Software

Before uninstalling the NI-CAN software, remove all CAN and LIN
hardware from your computer.

Complete the following steps to remove the NI-CAN software.

1. Run the Add/Remove Programs applet from the Control Panel.
2. Select National Instruments Software. Click the Change button.
3. Select NI-CAN in the list of products and click Uninstall.

The uninstall program removes all folders, utilities, device drivers, DLLs,
and registry entries associated with the NI-CAN software. The uninstall
program removes only items that the installation program installed.

If you have added anything to a directory created by the installation
program, the uninstall program cannot delete that directory because it is not
empty after the uninstallation. Remove any remaining components
manually.

After the uninstall program completes, restart your computer.

Further Documentation

Complete documentation is in the NI-CAN Hardware and Software
Manual, which is available on your NI-CAN Software for Windows CD in
Adobe Acrobat portable document format (PDF). The manual includes a
Troubleshooting and Common Questions section with more detailed
information on installation and configuration of your NI-CAN software
and hardware. Refer to the file NI-CAN Hardware and Software
Manual .pdf on the CD or in the NI-CAN\Documentation folder on
your hard drive.
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INSTALLATIONSHINWEISE
NI-CAN"-Software und -Hardware

Die Installationshinweise helfen Thnen bei der Installation der Software
und Hardware von National Instruments. Eine vollstdndige Dokumentation
finden Sie im Handbuch NI-CAN Hardware and Software Manual, das sich
im PDF-Format auf der CD NI-CAN-Software fiir Windows befindet. Das
Handbuch finden Sie in Form der Datei NI-CAN Hardware and
Software Manual.pdf auf der CD oder im Ordner NI-CAN\
Documentation auf Threr Festplatte.

Die NI-CAN-Software auf dieser CD gilt fiir Microsoft Windows-
Betriebssysteme.

Diese Installationshinweise umfassen alle NI-Hardware-Produkte fiir CAN
und LIN mit PCI-, PCMCIA-, PXI- und USB-Bus und setzen Kenntnisse
im Umgang mit Windows voraus.

Installieren der NI-CAN-Software (vor der Hardware)

Vor der Installation der CAN-Software miissen Sie sich als
Administrator oder als Benutzer mit Administratorrechten anmelden.
Fiir das NI-CAN-Installationsprogramm werden Administratorrechte
benotigt, da das Programm die Konfiguration Thres Systems dndert.

Fiihren Sie zur Installation von NI-CAN folgende Schritte aus:

1. Legen Sie die CD NI-CAN-Software fiir Windows in Thr CD-ROM-
Laufwerk ein. Wenn das CD-ROM-Laufwerk Daten-CDs automatisch
abspielt, startet nun die Installation.

Wenn die Installation nicht automatisch startet, wechseln Sie im
Windows-Explorer zur CD NI-CAN-Software fiir Windows und 6ffnen
Sie die autorun-Datei.

2. Der Installationsassistent fiihrt Sie durch die Installation von NI-CAN.
Uber die Schaltfliche Zuriick konnen Einstellungen bei Bedarf nach-
traglich gedndert werden. Zum vorzeitigen Beenden des Installations-
programms klicken Sie auf Abbrechen.

3. Fahren Sie Ihren Computer nach vollstindiger Installation herunter.

4. Fahren Sie beim Abschnitt Installieren der Hardware fort.

National Instruments, NI, ni.com und LabVIEW sind Marken der Firma National Instruments Corporation. Nahere Informationen zu den Marken von
National Instruments finden Sie im Abschnitt Terms of Use unter ni . com/1legal. Sonstige hierin erwdhnte Produkt- und Firmenbezeichnungen
sind Marken oder Handelsnamen der jeweiligen Unternehmen. Néhere Informationen iiber Patente auf Produkte von National Instruments finden Sie
unter Hilfe»Patente in lhrer Software, in der Datei patents . txt auf hrer CD oder unter ni . com/patents.

371427B-0113 © 2005-2006 National Instruments Corp. Alle Rechte vorbehalten. Oktober 2006



@ Hinweis Wenn Sie LabVIEW Real-Time (RT) verwenden, finden Sie im Abschnitt
LabVIEW Real-Time (RT) Configuration des Kapitels 2, Installation and Configuration,
im NI-CAN Hardware and Software Manual weitere Informationen zur Installation von
NI-CAN auf dem RT-System und zum Priifen der Installation.

Installieren der Hardware

In diesem Abschnitt wird beschrieben, wie CAN-Hardware mit PCI-,
PCMCIA-, PXI- oder USB-Bus installiert wird.

Installieren von PCI-Karten

A Vorsicht! Bevor Sie die Karte aus der Verpackung nehmen, halten Sie die antistatische
Kunststoffverpackung zur Entladung an ein Metallteil Thres Computergehiuses, da die
CAN-Karte durch elektrostatische Entladungen beschidigt werden kann.

1. Stellen Sie sicher, dass Ihr Computer ausgeschaltet und vom Strom-
netz getrennt ist.

2. Entfernen Sie die Abdeckung des Computers, um an die Erweiterungs-
steckplitze zu gelangen.

3. Wiihlen Sie einen freien PCI-Steckplatz.

4. Entfernen Sie die entsprechende Steckplatzabdeckung an der Riick-
seite des Computer.

5. Stecken Sie die CAN-Karte in den Steckplatz. Wenden Sie beim Ein-
fiihren der Karte keine Gewalt an.

6. Verschrauben Sie die Halterung der CAN-Karte mit der Schiene an der
Riickseite Ihres Computers.

7. Verbinden Sie ggf. den RTSI-Anschluss der CAN-Karte iiber ein
RTSI-Kabel mit anderer RTSI-fahiger Hardware von
National Instruments. Weitere Informationen zu RTSI finden Sie im
Abschnitt RTSI von Kapitel 3, NI CAN and LIN Hardware, des
NI-CAN Hardware and Software Manuals.

8. Bringen Sie die obere Abdeckung oder die Abdeckung des Erweite-
rungssteckplatzes wieder an.

9. Fahren Sie beim Abschnitt Priifen der Installation fort.

NI-CAN-Software- und -Hardware-Installationshinweise 14 ni.com



Installieren von PCMCIA-Karten

A Vorsicht! Bevor Sie die Karte aus der Verpackung nehmen, halten Sie die antistatische
Kunststoffverpackung zur Entladung elektrostatischer Energie an ein Metallteil Thres
Computergehauses, da die CAN-Karte sonst Schaden nehmen kann.

1. Fiihren Sie die Karte in einen freien PC-Steckplatz (PCMCIA) ein.

2. Verbinden Sie das PCMCIA-CAN-Kabel mit der Karte. Die
NI-CAN-Software erkennt automatisch, welches Kabel mit der Karte
verbunden wurde.

3. Mithilfe eines PCMCIA-CAN-Synchronisationskabels konnen Sie
Thre PCMCIA-CAN-Karte mit dem Zeitgeber und Triggersignalen
einer anderen Karte verbinden.

Weitere Informationen zur PCMCIA-CAN-Synchronisations-
schnittstelle finden Sie im Abschnitt PCMCIA-CAN des Kapitel 3,
NI CAN and LIN Hardware, im NI-CAN Hardware and Software
Manual.

4. Fahren Sie beim Abschnitt Priifen der Installation fort.

Installieren von PXI-Karten

A Vorsicht! Bevor Sie die Karte aus der Verpackung nehmen, halten Sie die antistatische
Kunststoffverpackung zur Entladung elektrostatischer Energie an ein Metallteil Thres
Computergehiuses, da die CAN-Karte sonst Schaden nehmen kann.

1. Stellen Sie sicher, dass das PXI- oder CompactPCI-Gehéuse ausge-
schaltet und vom Stromnetz getrennt ist.

2. Waibhlen Sie einen freien PXI- oder CompactPCI-Steckplatz.
Entfernen Sie die Blende des Steckplatzes.

4. Beriihren Sie zur elektrostatischen Entladung ein Metallteil des
Computer-Gehiuses.

5. Fiihren Sie die PXI-Karte in den Steckplatz ein und befestigen Sie den
Arretierhebel.

6. Befestigen Sie die Frontplatte der PXI-Karte an der Fronthalterung des
PXI- oder CompactPCI-Gehiuses.

7. Fahren Sie beim Abschnitt Priifen der Installation fort.

© National Instruments Corporation 15 NI-CAN-Software- und -Hardware-Installationshinweise



Installieren von USB-Hardware

A Vorsicht! Bevor Sie die Karte aus der Verpackung nehmen, halten Sie die antistatische
Kunststoffverpackung zur Entladung elektrostatischer Energie an ein Metallteil Thres
Systemgehiuses, da die CAN- oder LIN-Hardware sonst beschiadigt werden kann.

Verbinden Sie das USB-Kabel mit einem freien USB-Anschluss
(1.1 oder 2.0). Die NI-CAN-Software erkennt CAN- und LIN-
USB-Hardware automatisch.

USB-Hardware mit Synchronisierungsoption kann mit dem Zeitgeber
und Triggersignalen einer anderen Karte verbunden werden.

Weitere Informationen zur USB-847x-Synchronisationsschnittstelle
finden Sie im Abschnitt USB-847x des Kapitels 3, NI CAN and LIN
Hardware, im NI-CAN Hardware and Software Manual.

Fahren Sie beim Abschnitt Priifen der Installation fort.

Priifen der Installation

1.

Schalten Sie Thren Computer ein.

Daraufhin wird das Dialogfeld “Neue Hardware gefunden” angezeigt.
Wenn das Dialogfeld nicht automatisch ausgeblendet wird, wihlen Sie
die Standardoption Automatische Installation der Software (Emp-
fohlen). Daraufhin installiert das Betriebssystem die Treiber.

Wenn das Dialogfeld “Neue Hardware gefunden” nach dem Neustart
von Windows nicht angezeigt wird, lesen Sie den Anhang
Troubleshooting and Common Questions im NI-CAN-Hardware and
Software Manual.

Starten Sie den Measurement & Automation Explorer (MAX) und
aktualisieren Sie die Ansicht (driicken Sie <F5> oder wihlen Sie
Ansicht»Aktualisieren aus dem Menii). Ihre CAN- und LIN-
Hardware sollte jetzt unter Gerite und Schnittstellen aufgelistet sein.
Um alle gefundenen CAN- und LIN-Gerite zu testen, wéhlen Sie
Werkzeuge»NI-CAN»Alle lokalen Karten testen.

Fahren Sie beim Abschnitt Anschlieffen der Kabel fort.

AnschlieBen der Kabel

SchlieBen Sie nach Installation der Hardware die Kabel an. Wie CAN- und
LIN-Hardware zu verkabeln ist, erfahren Sie in Kapitel 4, Connectors and
Cables, im NI-CAN Hardware and Software Manual.
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Deinstallieren von NI-CAN

Trennen Sie vor der Deinstallation von NI-CAN alle CAN- und LIN-
Gerite von Threm Computer.

Fiihren Sie zur Deinstallation von NI-CAN folgende Schritte aus:
1. Klicken Sie in der Systemsteuerung auf Software.

2. Klicken Sie auf National-Instruments-Software. Klicken Sie auf die
Schaltfliche Andern.

3. Wihlen Sie NI-CAN aus der Liste aus und klicken Sie auf
Deinstallieren.

Wihrend der Deinstallation werden alle Ordner, Hilfsprogramme, Gerite-
treiber, DLLs und Registry-Eintrige zu NI-CAN entfernt. Bei der
Deinstallation werden nur die Elemente entfernt, die zuvor installiert
wurden.

Wenn ein vom Installationsprogramm erzeugter Ordner nicht leer ist, weil
Sie ihm manuell Dateien hinzufiigt haben, kann dieser Ordner nicht
geloscht werden. Entfernen Sie alle verbleibenden Dateien und Ordner
manuell.

Starten Sie IThren Computer nach Beendigung der Deinstallation neu.

Weitere Dokumentation

Eine vollstindige Dokumentation finden Sie im NI-CAN Hardware and
Software Manual, das sich im PDF-Format auf der CD NI-CAN-Software
fiir Windows befindet. Das Handbuch enthilt einen Abschnitt mit dem Titel
Troubleshooting and Common Questions mit weiteren Informationen zur
Installation und Konfiguration Ihrer NI-CAN-Software und -Hardware.
Das Handbuch finden Sie in Form der Datei NI-CAN Hardware and
Software Manual.pdf auf der CD oder im Ordner NI-CAN\
Documentation.
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